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Science Analysis Tools

» Overview of capabilities

— Maximum likelihood tool—spatial-spectral
analysis of region (source detection, flux)

 Includes background models

— Pulsars—period analysis, blind searches
* Includes ephemerides DB

— Simulation tools

» Tools and documentation are released through
FSSC website (http://fermi.gsfc.nasa.gov/ssc/)
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Science Tools: Documentation

» Multi-tier Documentation
— Full set accompanies software release
* Fermi Mission Technical Handbook
— Multiple levels:
» Detailed analysis description
(‘Cicerone’)
* Individual tool descriptions (like fhelp)

* Analysis threads (cook book
examples)
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Science Tools: Structure

» “Atomic” executables
— Allows for divergent analysis without task repetition
— Scriptable into more complex analysis chains

» file types
— FITS data i/o
— IRAF style param files
— XML source models
— Text-based supporting files

» Compatible with toolsets
— FV, DS9, XSPEC
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Simulation
gtorbsim
gtobssim

Science Tools: Flowchart
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Parameter Files

» Contain parameter defaults or previous values

#
# $Header: /nfs/slac/afglastfground/cvs /dataSubselector /pfiles/gtselect.par,v 1.16
@

infile,fy,a,"",,,"Input FT1 file"
outfile,f,a,"",,,"Output FT1 file"

ra,r,a,d8,8,368,RA for new search center {(degrees)
dec,r,a,8,-98,98,0ec for new search center {(degrees)
rad,r,a, 188,08, 188,radius of new search region {(degrees)
tmingr,a,8,8,,start time (MET in s)

tmax,r,a,8,8,,end time {(MET in s)

eminyr,a,38,8,, lower energy Llimit {Me¥)

emax,r,a, 300000,0, ,upper energy limit {MeV)
zZmax,r,a, 188,08, 188, maximum zenith angle value {(degrees)
evclsmingi,h,3,8,18,"Minimum event class D"

evclsmax, i,h,3,8,18, "Maximum event class D"

convtype, i,h,=1,-1,1,"Conversion tuype {(-1=both, @=Front, 1=Back}"
phasemin,r,h,8,8,1,minimum pulse phase
phasemax,r,h, 1,8, 1 ,maximum pulse phase

evtable,s,h, "EVENTS",,, "Event data extension"

chatter,i,h,2,8,4,0utput verbosity

clobber, b, hy ues, , , "Overwrite existing output files"
debug, b, hy no, , , "Activate debugging mode"

Qui b, hy no, , , "GUI mode activated"

mode, s, hy, "ql"y, , 4 "Mode of qutomatic parameters"
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Science Tools: Execution

» Parameters can be input in three ways
— Command line entry - useful for scripting

» Allows modification of “hidden” parameters (likely not
needed for standard analyses)

— Last value stored in param file for next use
— Interactive prompted entry
 No access to hidden parameters

» Parameter input can be mixed

— %gtselect
— %gtselect clobber=no

— %gtselect clobber=no, infile=events.fits,
outfile=events_cut.fits, etc...
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Data Access: File types

» Events File (2 types)
— Photon files contain all needed information for science analysis

— Extended files contain additional information about each event that
is used for specialized analysis

* not needed by any science analysis tool
— All event classes are available in both file types

« Diffuse - Highest quality, lowest background contamination, Use this
for most analyses!

« Source - Moderate quality

« Transient - Loose quality definition, significant background
contamination

» Spacecraft File

— Spacecraft Orientation and orbit position information (where are we
and where are we pointed)

— One entry every 30 seconds
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Data Access: Downloads

» Download data from:

— http:/l[fermi.gsfc.nasa.gov/ssc/data/analysis/scitools/extract_latdat
a.html

» Allows retrieval of data for a specified region

« Default values correspond to suggested data selections for
most analysis types

— http://fermi.gsfc.nasa.gov/cgi-bin/ssc/LAT/WeeklyFiles.cgi

* Weekly files contain only Diffuse-class events from the photon
files

+ Weekly spacecraft files are also available

— FTP: Can be retrieved automatically using wget
« Spacecraft: ftp://legacy.gsfc.nasa.gov/fermi/data/lat/weekly/
* Photon: ftp://legacy.gsfc.nasa.gov/fermi/data/lat/allsky/
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This is the portal to the Fermi data and the software to analyze them. Before the data or software are released,
they are described here.

Data
® Data Access - the Fermi science data
Data Policy e Data Analysis - the software to analyze Fermi data

Data Access e Data Policy - a summary of the policies governing the release of Fermi science data

As a resource for cycle-3 proposers the Fermi LAT consortium, through an agreement with NASA, has provided a
source catalog based on data from the first year of the mission.

Data Anal
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+ Get Plugins (Acrobat, etc.) Responsible NASA Official: Phil Newman
+ Contact NASA NASA Science Official: Neil Gehrels
+ Learn More About Fermi

+ FSSC Helpdesk Last Modified: Mon, Feb 01, 2010

€ Find: (Q profi D) (Next I Previous) (: Highlight all) [] Match case

Done V7

Julie McEnery July 8, 2010 10



®e0o FSSC: Data » Data Access =

} @ @ @ ( E http://fermi.gsfc.nasa.gov/ssc/data/access/

Most Visited ¥  Getting Started Latest Headlines  Yahoo!

e a X, /
2Clience oupport wenter

m OBSERVATIONS DATA PROPOSALS LIBRARY HEASARC HELP SITE MAP

+ FSSC Home Currently Available Data Products

The Fermi data released to the scientific community is governed by the data policy. The released instrument data
for the GBM, along with LAT source lists, can be accessed through the Browse interface specific to Fermi. LAT
photon data can be accessed through the LAT data server.

Data

Data Policy The FITS files can also be downloaded from the Fermi FTP site. The file version number is the 'xx' in the

characters before the extension in each filename; you should keep track of the version numbers of files you

analyze since the instrument teams may update them.
+ LAT Data

+ LAT Catalog ® LAT Photon and Extended Data
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GBM Trigger Catalog
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GBM Daily Data

GBM Earth Occultation Light Curves
GBM Pulsar Spin Histories

® Spacecraft Data
o Spacecraft Pointing Files

The analysis tools that are currently available to analyze GBM data, and documentation of the analysis system,
are available here.

Note that the LAT and GBM data are accompanied by caveats about their use.
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Additional Fermi Information

Newsletters/
mailing lists

Quicklook
results from the
instrument
teams
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+ Privacy Policy and Importa
+ Get Plugins (Acrobat, etc.)

Currently Available Data Products

The Fermi data released to the scientific community is governed by the data policy. The released
instrument data for the GBM, along with LAT source lists, can be accessed through the Browse
interface specific to Fermi. LAT photon data can be accessed through the LAT data server.

The FITS files can also be downloaded from the Fermi FTP site. The file version number is the 'xx'
in the characters before the extension in each filename; you should keep track of the version
numbers of files you analyze since the instrument teams may update them.

® LAT Photon and Extended Data
© LAT Data Server
® LAT Data (high-level products only)

© LAT Monitored Source List
© LAT Monitored Source List Light Curves
© LAT Pulsar Ephemerides

© LAT Burst Catalog

© LAT 1-year Point Source Catalog (New!)
© LAT Bright Source List

© LAT Background Models

* GBM Data

© GBM Trigger Cataleg

© GBM Burst Catalog

© GBM Daily Data

Q lBSBM Earth Occultation Light Curves
BM Pulsar Spin Histories

e Spacecraft Data
© Spacecraft Pointing Files

The analysis tools that are currently available to analyze GBM data, and documentation of the
analysis system, are available here.

Note that the LAT and GBM data are accompanied by caveats about their use.

nt Notices Curator: 1.D. Myers

Responsible NASA Official: Phil Newman

July 8, 2010

elpdesk



Fermi Mailing lists

« http://fermi.gsfc.nasa.gov/ssc/resources/newsletter/
— fermi-news - General news about the Fermi mission

— Gammamw - Information on multiwavelength observations
relevant to fermi

— fermi-soft - Information/updates on Fermi science
data/software
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LAT monitored source list

The LAT team releases @00 @ L Q FSSC: Data » Data Access » LAT S
- < http://fermi.gsfc.nasa.gov/ssc/data/access/lat/msl_Ic/ ',,'.,‘V L= [g' Google Q)
flux/spectra as a function of DI e |

time for all sources in a pre- f ‘""'wm;‘;'u,,pon‘;e,.w,
[ eesounees T rnorosms T o T —mome e e |

defined IiSt + flaring Sources + FSSC Home Monitored Source List Light Curves
during flares. ——

4C 31.03

. Data Policy (RA = 18.2100, Dec = 32.1380)
 Modified data release after rosly o euve

+ LAT Data » Weekly Light Curve

~ m n h - + LAT Catalog (New!) » Weekly Light Curve Fits File
u + GBM Data

Data Analysis

0208-512
Newsletter (RA = 32.6930, Dec = -51.0170)

 Lowered flux threshold

» Daily Light Curve Fits File
» Weekly Light Curve

to release information » Weekly Light Curve Fits File
on flaring sources by

(RA = 35.6650, Dec = 43.0350)

» Daily Light Curve
factor of 2 » Daily Light Curve Fits File
. » Weekly Light Curve

» Weekly Light Curve Fits File

* Provided information

(RA = 39.6620, Dec = 16.6160)
» Daily Light Curve

continuously (not just o e
during flares).

 started with 23
sources, now have >40

LSI +61 303
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http://[fermisky.blogspot.com/

WEDNESDAY, JUNE 3, 2009

Fermi LAT Weekly Report N. 52

FERMI GAMMA-RAY SKY

LAT DATA

LAT Monitored Source List Light

Curves:

Covered period: 2009.May.25 - 2009.May.31

¢ Candidate blazar 4C31.03 (see ATel #2054) seen in day
timescales with flux levels reaching 0.8e-6 ph/cm”2/s.

¢ PKS 1510-089 remains in the 1e-6 to 2e-6 daily flux range
(>100MeV)

¢ PKS 1502+106 shows a steady trend with daily fluxes
(>100MeV) around 1e-6 ph/cm”2/s.

¢ 3C 454.3 showed consistent daily flux levels (>100MeV) just

below 1e-6 ph/em”2/s.

LAT Bright Source List

Browse interface to monitored source
data

BLOG ARCHIVE
¥ 20009 (8)
¥ June (1)
Fermi LAT Weekly Report N. 52
» May (4)

P April (3)

CONTRIBUTORS

Flare Advocate

Julie McEnery July 8, 2010
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http://[fermisky-daily.blogspot.com/

Daily Fermi Gamma-Ray Sky

http://fermisky-daily.blogspot.com/

X,

Share Report Abuse Next Blog»

jemcenery@yahoo.com New Post

DAILY FERMI GAMMA-RAY SKY

THURSDAY, FEBRUARY 18, 2010
Daily report - February 17, 2010

Extragalactic Science

* PKS 0537-441 (TS=78) at (0.8 + 0.3) x 10-6

* Mkn 421 (TS=111 !!!) at (0.3 + 0.1) x 10-6 Note the index: 1.39 + 0.17

* 4C +21.35 (TS=84) at (0.96 + 0.31) x 10-6
* 3C 454.3 (TS=242) at (2.77 + 0.45) x 10-6

Unidentified source

* 1FGL J0623.5+3330 (TS=40), yet unassociated, at (0.5 = 0.22) x
10-6

POSTED BY JULIE AT 7:50 PM 0 COMMENTS /

Daily Report - February 16, 2010
Extragalactic Science

* Mrk421 detected with a daily flux below 0.5E-6

* 4C 21.35 with TS=79 and a daily flux of (0.8 = 0.3)E-6

* J1332-0509 detected with a daily flux of (0.9 + 0.3)E-6 and TS=22
* 3C 454.3 with a daily flux of (3.9 = 0.6)E-6

POSTED BY JULIE AT 1:43 AM O COMMENTS /

WHAT IS THIS?

This is a copy of the daily
communication from the LAT Flare
Advocate (team member following up
on flaring activity found in the LAT
data) to the LAT team. Since this is
largely a verbatim copy of an internal
communication, you may notice some
internal jargon - we apologize in
advance for this.

The purpose of this blog is to publicly
provide information about the activity
in the high energy gamma-ray sky
with lower latency than the main sky
blog. >

LAT DATA

Main FermiSky blog

Contact Information by Individual
Sources

Browse interface to monitored source
data

LAT First Catalog

LAT Monitored Source List Light
Curves F

Google

Customize

Sign Out

l«I»

Julie McEnery

July 8, 2010

16




If you have more questions...

® 00

FSSC: Help

(GD 1/6\ '/?\ '/;\l E http://fermi.gsfc.nasa.gov/ssc/help/

Most Visited ¥  Getting Started Latest Headlines »
—

2.4 Jointan.. E Unbinn... 10p Fermi p-..

GODDARD

SPACE FLIGHT CENTER

Fermi

Science Supp

+ NASA Homepage
+ GSFC Homepage
+ Fermi Homepage

enter

o resounces [ mmoroms | o e | e | s

+ FSSC Home

Help Desk

FAQ

Newsletter

About the FSSC

+ Privacy Policy and Important Notices
+ Get Plugins (Acrobat, etc.)

+ Contact NASA
+ Learn More About Fermi
+ FSSC Helpdesk

Help Desk

Please Note: As a result of technical issues, the Fermi SSC Help facility was off line from
February 9-13, 2009. All inquiries submitted during that time were lost. We apologize for this
inconvenience. Please resubmit any correspondences you may have attempted during that time
interval.

If you have a general question about Fermi, Fermi science or classroom materials, please contact
Fermi Answers

If you have a question about the Fermi GI program or analyzing Fermi science data please submit
your query through the HEASARC Feedback form. Please be sure to select "Fermi" from the
mailing list option.

Curator: 1J.D. Myers
Responsible NASA Official: Phil Newman
NASA Science Official: Neil Gehrels

Last Modified: Wed, Jul 01, 2009

Julie McEnery

July 8, 2010

The helpdesk!

Or send mail directly to glasthelp@milkyway.gsfc;.nasa.gov
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Event selection

 Use Events >100 MeV for spectral analysis

— To avoid spurious features due to rapidly changing
effective area with energy and because of residual
uncertainty in the instrument response.
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Flux [HeV/cn"2 s srl

Event selection

« Use "Diffuse” class for diffuse, extended, and point source analysis.
(evelsmin=3, evclsmax=4). NOTE - this applies to P6 IRFs only, future
recommended event selections might change.

— Other event classes have higher charged-particle background
contamination and may result in spurious spectral features.

0.01 : : , —— Residual cosmic-ray

Both s (charged particle)
Both (9 month data) —&— ackgr()und

. 8 Spectral templates are provided for
voon | . P ox | the diffuse class event selection that
) allow you to account for the presence

- of residual cosmic-ray backgrounds
*o: i I in your model fits.

8.00801

L 1 L 1
10 100 1000 10000 160000 1e+06
E [Hev]
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The Earth is Bright!

GREBOSQ90ZB
Fermi LAT

deg of the Earths limb (zenith angle of 105 deg)
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Preparing your data

* Prior to beginning an analysis you must:
— Select the event class (Diffuse in almost all cases)

— Exclude time intervals where the bright Earth limb comes
close to your region of interest (zenith angle of 105
degrees)
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Data Selection - 1

» Event-specific cuts can be made with gtselect
— Time range, energy range, position, ROl radius, zenith angle

» Temporal cuts using spacecraft file keywords are made with
gtmktime

— This MUST be applied if a zenith cut was used with gtselect

[wche-2-147-1168:Meet ings/0ct2089_workshop/3c454_workshop] eferrara® gtmktime
Spacecraft data file[3c454_ecut.fits] LB98923112602E0D2F37ETL_SCAB.fits

Filter expression[DATA_QUAL==1]

Apply ROI-based zenith angle cut[ves]

Event data file[LB98521150043E0D2F37E96_cut.fits] 3c4b4_ecut.fits

Output event file name[LB983211560043EADZ2F37E96_gticut.fits] 3c454_ecut_gti.fits
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Data Selection - 2

» Different cuts should be used for different types of data analysis
— Point Source analysis

- For hard spectrum sources, may benefit from a higher
minimum energy cut due to energy-dependent PSF

— Pulsar Timing analysis

- Requires that spacecraft file span a greater time range than
event file

— GRB analysis (<200 s)
- Uses “Transient” class photons (evclsmin=1, evclsmax=4)

» The current set of cuts can be reviewed using gtvcut

» Recommended cuts are documented at:

http://fermi.gsfc.nasa.gov/ssc/data/analysis/documentation/Cicerone/Cicerone _Data Exploration/Data_preparation.html
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Binning for Visualization - 1

» gtbin can be used to create several useful visualization
products

— Raw counts map
— Quick-look light curve
— PHA1 file

» Results are in format used by other science tools like XSPEC
— Includes WSC keywords for ease of viewing

» Useful to get a rough idea of the data, but do not include:
— Exposure correction
— Instrument responses
— Requires Likelihood analysis for valid results
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Making a counts lightcurve

« gtselect evclsmin=3 evclsmax=4 infile=3c454.3 long_ PHO00.fits
outfile=3c454.3 long_3deg_sel.fits ra=343.490616 dec=16.148211
rad=3 tmin=278121600 tmax=286070400 emin=100 emax=300000

zmax=105
« gtmktime scfile=3c454.3_long_SCO00.fits filter="(DATA_QUAL==1)"

roicut=yes evfile=3c454.3 long_3deg_sel.fits
outfile=3c454.3 long_3deg_ mktime.fits

— e — - -

mcenery-2:amsterdam mcenery$ gtbin

This is gtbin version ScienceTools-v9rl5p2-fssc-20090808
Type of output file (CCUBE|CMAP|LC|PHAL1|PHA2) [LC]

Event data file name[3c454.3_Dec2009_3deg_mktime.fits] 3c454.3_long_3deg_mktime.
fits

Qutput file name[lc_3c454.3_3deq.fits]

Spacecraft data file name[NONE]

Algorithm for defining time bins (FILE|LIN|SNR) [LIN]
Start value for first time bin in MET[280800000] 278121600
Stop value for last time bin in MET[282009600] 286070400
Width of linearly uniform time bins in seconds[86400]

Note that the resulting lightcurve, lc_3c454.3_long_3deg.fits, is not
background subtracted or exposure corrected!
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Exposure vs time

The exposure (effective area x live time) can vary from interval
to interval (because the target moves around the FoV).

gtexposure adds a column to the Ic file containing the exposure
for each time interval.

mcenery-2:amsterdam mcenery$ gtexposure
Light curve file[lc_3c454.3_3deqg.fits]
Spacecraft file[3c454.3_long_SC@0.fits]
Response functions[P6_V3_DIFFUSE]

Source model XML file[none]

Photon index for spectral weighting[-2.1]
mcenery-2:amsterdam mcenery$ [
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COUNTS

Plotting the results (using fv)

lc_3c454.3 3deg.fits(COUNTS_1-92)

Counts)

|
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e
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Counts vs time
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Counts map

gtselect evclsmin=3 evclsmax=4 infile=3c454.3_long_PHO00.fits
outfile=3c454.3 long_15deg_sel.fits ra=343.490616 dec=16.148211
rad=15 tmin=284256002 tmax=286070400 emin=100 emax=300000
zmax=105

gtmktime scfile=3c454.3 long_SCO00.fits filter="(DATA_QUAL==1)"
roicut=yes evfile=3c454.3 long_15deg_sel.fits
outfile=3c454.3 long_15deg_mktime.fits

gtbin algorithm=cmap evfile=3c454.3 _long_15deg_mktime.fits
outfile=cmap_3c454.3 15deg.fits scfile=3c454.3 long_SCO00.fits
nxpix=60 nypix=60 binsz=0.5 coordsys=cel xref=0 yref=0 axisrot=0
proj=ait
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View region with ds9

eno X' SAOImage ds9
File Edit View Frame Zoom Scale Color Region WCS Analysis Helpl
File cmap_3c454.3_15deg.fits ' .
Object >ds9 cmap_3c454.3_15deg.fits
Value 2
FK5 ¢ | 22:07:32.974 | 3 | +09:38:47.74 |
Physical X 53.400 Y 18.133
Image X 53.400 Y 18.133
Frame1 Zoom | 7.500 Angle | 0.000
file ‘ edit ‘ view ‘ frame ‘ ‘ zoom ‘ scale ‘ color region ‘ wcs ‘ help ’
grey ‘ a ‘ b bb ‘ he ‘ i8 ‘ aipso ‘ heat ‘ cool ‘ rainbow ’

57 71 85 33 114 128

JUTY™8;,72U0TU



All-sky exposure map

« To get a sense of the nature of an observation, it can be useful
to make (and look at ) an all-sky exposure map.

Start by making a livetime cube (this creates a histogram of the livetime vs
inclination angle for each bin on the sky)

mcenery-2:amsterdam mcenery$ gtltcube

Event data file[3c454.3 _Dec2009 _mktime.fits] 3c454.3_long_15deg_mktime.fits
Spacecraft data file[3c454.3_Dec2009_SCO0.fits] 3c454.3_long_SCO0.fits
Output file[3c454.3 _Dec2009_expCube.fits] 3c454.3_long_expCube.fits

Step size in cos(theta) (0.:1.) [0.025]

Pixel size (degrees) [1]

Working on file 3c454.3_long_SC00.fits

mcenery-2:amsterdam mcenery$ [
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Making the exposure map

The livetime cube is convolved with the instrument response functions to
obtain an exposure map

mcenery-2:amsterdam mcenery$ gtexpcube

This is gtexpcube version N/A

Exposure cube input file name[3c454.3 long_expCube.fits]

FT1 events input file name[3¢c454.3 long_15deg_mktime.fits]

Count map input file name (NONE for manual input of map geometry)[NONE]

Exposure map output file name[expmap.fits]

Response function to use. Run gtirfs for a listfP6_V3 DIFFUSE]

Size of the X axis in pixels (leave at 1 for auto full sky (1:) [1]

Size of the Y axis in pixels (leave at 1 to copy nxpix or auto full sky) (1:) [1]

Image scale (in degrees/pixel)[1]

Coordinate system (CEL - celestial, GAL -galactic) (CEL|GAL) [GAL]

First coordinate of image center in degrees (RA or galactic 1)[0]

Second coordinate of image center in degrees (DEC or galactic b)[0]

Rotation angle of image axis, in degrees[0]

Projection method (AIT|ARC|CAR|ZEA|GLS|MER|NCP|SIN|STG|TAN) [AIT]

Start value for first energy bin[100] 1000

Stop value for last energy bin[10000] 1000

Number of logarithmically uniform energy bins[4] 1

How are energy layers computed from count map ebounds? (CENTER|EDGE) [CENTER]
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800

Fle Edit View Frame

All-sky exposure map

X! SAOImage ds9

i Zoom Scale Color Region WCS Analysis

File expmap.fits
Object
Value 1.62298e+08
FK5 09:18:31.569 | 3 [ -15:48:26.39 | e
Physical X 202.000 Y 65.500
Image X 202.000 Y 65.500
Frame 1  Zoom 2.000 Angle 0.000
file | edit | view | frame | ’ zoom | scale ” color region | wces | help |
grey a | b | bbb | he | 8 | aps0 | heat | |

1.80e+08

5.36e+08

Julie McEnery

8.93e+08

-

1.25e+03

July 8, 2010

4

ds9 expmap.fits

Try making an all-sky map
with the April 3c454
dataset (this contains a
pointed mode observation)
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Building a source model (1) - ModelEditor

e NoO ModelEditor (/Users/mcenery/fermi/school /amsterdam/model_simple.xml)
Title Source Library
Add 3;‘:-5$02 Source Name: 3c454 Source Type:PointSource
GALPROP EG_;OZ Spectrum Type: [PowerLawZ @ File: Browse
name value scale min max free
source Integral 1.0 1e-06 1e-05 1000.0 4
Index 20 1.0 5.0 1.0 4
LowerLimit [ 100 10 20.0 2000000 ™
Add UpperLimit | 200000.0 1.0 20.0 2000000 [
extragalactic
source (use
filefunction
Spec.l.r,al 1.ype Spatial Model Type: [SkyDirFunction Q File: Browse
. h name value scale min max free
WIT RA 343.491 1.0 0.0 360.0 =
lso’rr'oplc_lem_ DEC 16.1482 10 -90.0 90.0 O
v02.txt)
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mcenery-2:amsterdam mcenery$ gtexpmap

The exposure maps generated by this tool are meant
to be used for *unbinned® likelihood analysis only.
Do not use them for binned analyses.

Event data file[3c¢454.3 long 15deg mktime.fits]
Spacecraft data file[3c454.3 long_SCO00.fits]
Exposure hypercube file[3¢454.3 long_ expCube.fits]
output file name[3¢c454.3 long expMap.fits]
Response functions[P6_V3 DIFFUSE]

Radius of the source region (in degrees)[30]

Number of longitude points (2:1000) [120]

Number of latitude points (2:1000) [120]

Number of energies (2:100) [20]

Computing the ExposureMap using 3¢454.3 long_expCube.fits

Julie McEnery July 8, 2010

35



